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Before operating this software, please read these instructions completely and keep these operating instructions for future reference.
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The following trademarks and registered trademarks are used throughout this manual: 

Microsoft, MS-DOS, Windows and Windows NT are registered trademarks of Microsoft 
Corporation in the USA and other countries.
i386, i486 and Pentium are trademarks of Intel Corporation.
Centronics is a registered trademark of Centronics Data Computer Corporation.
TrueType is a registered trademark of Apple Computer, Inc.
All other trademarks identified herein are the property of their respective owners.

Copyright c 2000-2002 by Matsushita Graphic Communication Systems, Inc.
All rights reserved. Unauthorized copying and distribution is a violation of law.
Published in Japan.

The contents of these Operating Instructions are subject to change without notice.
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Precautions

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to
part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
Operating Guide, may cause harmful interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful interference in which case the
user will be required to correct the interference at his/her own expense.

Any unauthorized changes or modifications to this equipment would void the users authority to operate this
device.

Warning: To assure continued compliance, use only a shielded interface cable when connecting the   
                machine’s parallel interface port to the host computer. Also, any changes or modifications not 
                expressly approved by the party responsible for compliance could void the user's authority to
                operate this equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1)
This device may not cause harmful interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

• You need to read the software license agreement before setting up the Printer Driver.

• You need to read the following precautions which are described in the Operating Instructions (For
Facsimile).
1. Installation
2. Ventilation
3. Handling
4. Toner and Paper
5. For your safety

For Users in the USA
5
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External View and Control Panel

���� DP-3510/4510/6010

External View

Parallel Connector
    Connect to the PC

Network Interface Cable (CAT 5)
    Connect to your 10Base-T/100Base-TX Ethernet Network

Parallel Interface Cable
    Obtain a separately available cable conforming to the PC.
    (A cable does not come with the unit.)  Use a cable of IEEE 1284 

specification with a maximum length of 20 ft (6m).  Consult a 
service provider for details.

    Note: The parallel port is only available if using the printer driver.
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No. Name Function

MAIL BOX Used to print or delete the print data.  This feature is available if the optional Hard
Disk Drive Unit (DA-HD60) is installed. (See page 8)

JOB CONTROL Selects printer jobs.

OFF LINE Switches the printer to off-line status. (The printer cannot be set off-line when the
DATA indicator is blinking.

ON LINE Switches the printer from off-line status to on-line status.

CANCEL PRINT Used to cancel the print job.

JOB QUEUE
Selects print job priority or deleting print data and to view all pending print or copy
jobs.
 (See page 9)

ON LINE Indicator Lit  : Printer is operational online 
Off  : Printer is offline

DATA Indicator
Blink  : Data is being received from the PC.
On  : Printing is under operation.
Off  : Printer is in standby or printing has been completed.
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Control Panel

���� MAIL BOX

Enter User ID and press  key.

No. Name Function

Print Jobs Indicates all current and/or pending print jobs.

SELECT ALL Selects all print jobs. (For MAIL BOX only)

PRINT Prints the job.
Machine prompts for  the 4-digit password if printing from Security Box.

DELETE Deletes print job(s).
Machine prompts for  the 4-digit password if deleting from Security Box.

CLOSE Closes this screen.

OK

Select MAIL BOX or SECURITY BOX.
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JOB OWNER FILE NAME STATUS TIME #OFSETS PAGES JOB TIME
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���� JOB QUEUE

No. Name Function

Print Jobs Indicates all current and/or pending print jobs.

SELECT ALL Selects all print jobs.

PRIORITY Sets to change the print job(s) priority.  This feature is available if the optional Hard
Disk Drive Unit (DA-HD60) is installed.

DELETE Deletes print job(s).

CLOSE Closes this screen.

Enter the 4-digit password
and press OK key.
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Printer Section

Installing the Printer Driver 

Windows 98/Me/NT/2000/XP

1 Insert the Panasonic Document Management 
System CD-ROM.

2 Click on the desired language.

3 Click the  button.

4 Click Printer Driver.

Note: The Fax Gateway and Firmware Update 
Utility is available in the U.S.A. only.

5 Note for Windows 98/Me users:
If your computer does not have the LPR Port 
Monitor installed, please proceed to "Installing 
the LPR Monitor" on page 13 before 
continuing this installation.

Click Install Printer Driver.

Next
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Windows 98/Me/NT/2000/XP
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6 Select your machine's model(s) check box 

and click the  button.

7 Check LPT1: and click the  

button.
(See Note 2 on the next page)

8 Click the  button if you would like 

to change your current default printer to the 
one that you are installing.

Note: This dialog box only appears if another 
printer is already installed.

9 Select your new default printer from the New 

Printer List and click the  button.

Next

Next

Yes

Next

Continued on the next page...
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Windows 98/Me/NT/2000/XP
The Panasonic/Panafax Printer Driver have been installed, and the Panasonic/Panafax Printer icon(s) have
been added to the Printer folder.

If you are installing the Printer Driver for network printing, please contact your network administrator for the
IP Address of the machine and proceed to the next section to install the LPR Monitor service for the version
of Windows you are using after your computer has rebooted.

NOTE 1. When installing on Windows NT 4.0 and Windows 2000/XP, logon to the computer/network
using an account with administrator rights.

2 If the LPR Monitor is already installed on your PC, select  Create New Port in step 7. Then,
select Search the network printer to search the machine(s) connected on your network.

10 The required files are copied.

11 When the setup process is completed, a 
message is displayed prompting you to restart 
your computer.

Click the  button to restart your 

computer.

Finish
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Installing the LPR (Line Printer Remote) Monitor

Windows 98/Me

1 Insert the Panasonic Document Management 
System CD-ROM.

2 Click on the desired language.

3 Click the  button.

4 Click Printer Driver.

Note: The Fax Gateway and Firmware Update Utility is 
available in the U.S.A. only.

5 Click Install LPR Monitor.

Next

Continued on the next page...
13
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Windows 98/Me
6 The Setup dialog box appears.

Click the  button.

7 The setup program copies the necessary files onto
the hard disk of your PC.
When the setup process is completed, a message
is displayed prompting you to restart your
computer.
It is recommended that you restart your computer
now so that the LPR Monitor can be started.

Click the  button.

8 If you have not installed the printer driver yet, please 
proceed to "Installing the Printer Driver" on page 10.

After your computer has rebooted, click the Start 
button, select Settings, and then click Printers.

The Printers folder appears.

Right-click on the desired printer icon and select 
Properties from the pop-up menu.

Next

OK
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Windows 98/Me
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9 The printer properties dialog box appears.

The following step registers the LPR Port for network 
printing.

Before proceeding, ensure that the printer is 
installed, connected to the network, turned ON and is 
operating properly.

10 Select the Details tab and click the  

button.

11 The Add Port dialog box appears. Click the Other 
radio button, select HLPRMON from "Click the type 
of port you want to add:" list, and click the 

 button.

Add Port...

OK

Continued on the next page...
15
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Windows 98/Me
NOTE 1. To print data via LAN, the LPR Monitor must be installed on your PC.

12 The LPR Port Name dialog box appears.

Type the IP Address of the machine and "lp" as the 
queue name separated by a ":" (colon).

Ex: 10.74.229.105:lp

Click the  button. If an error occurs 

because the queue name had already been used for 
the same IP Address, select a different unique name 
such as "lpr".

13 The screen reverts to the Printer Properties.

Check that the "Print to the following port:" has been 
changed as entered in step 12, and click on the 

Apply button first and then the  button.

The printer properties dialog box closes and you 
have now configured the printer as a network printer.

OK

OK
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Logon using an account with administrator rights.

Windows NT 4.0

1 Click the Start button, select Settings, and click 
Control Panel.

The Control Panel window appears.

Double-click on the Network applet.

The Network dialog box appears.

2 Click the Services tab.

Verify whether the LPR Service is already installed.
(Indicated by Microsoft TCP/IP Printing shown in the 
Network Services list.)

If it is already installed, skip to Step 7. Otherwise 
continue installing the LPR Service.

3 Click the  button to display the Select 
Network Service dialog box, and select Microsoft 
TCP/IP Printing.

Click the  button.

Add...

OK
17Continued on the next page...



Installing the LPR (Line Printer Remote) Monitor
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Windows NT 4.0
4 The Windows NT Setup dialog box appears.

Insert the Windows NT 4.0 CD-ROM, and type 
D:\i386 (where "D:" is your CD-ROM drive).

Click the  button.

5 After the files have been copied into the hard drive of 
your PC, the display returns to the Network dialog 
box. Confirm that the Microsoft TCP/IP Printing 
service has been added to Network Services list.

Click the  button.

Note: If the OK button does not change into a 
Close button, remove and reinstall the 
Microsoft TCP/IP Printing service. 

6 When Network Settings Change dialog box is 

displayed, click the  button to restart 

your computer now.

You have now completed the LPR Service 
installation.

7 After your computer has rebooted, log on with an 
account with Administrator Priviledges, click the Start 
button, select Settings, and then click Printers.

The Printers folder appears.

Right-click on the desired printer icon and select 
Properties from the pop-up menu.

Continue

Close

Yes
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Windows NT 4.0
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8 The following step registers the LPR Port for network 
printing.

Before proceeding, ensure that the printer is 
installed, connected to the network, turned ON and is 
operating properly.

Select the Ports Tab and click the   

button.

9 The Printer Ports dialog box appears.

Select LPR Port and click the  

button.

10 The Add LPR compatible printer dialog box 
appears.

Enter the IP Address of the printer in the upper field, 
and "lp" for the print queue name in the lower field.

Click the  button.

(Please wait while the wizard verifies the IP Address 
and connectivity to the network)

Add Port...

New Port

OK

Continued on the next page...
19
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Windows NT 4.0
11 The Printer Ports dialog box appears.

Click the  button.

12 Select the printer port and click the  

button.

The printer properties dialog box closes and you 
have now configured the printer as a network printer.

Close

OK
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Logon using an account with administrator rights.

Windows 2000/XP

1 Open the Printers folder.

Right-click on the desired printer icon and 
select Properties from the pop-up menu.

The printer properties dialog box appears.

2 Select the Ports Tab and click the  

 button.Add Port...

Continued on the next page...
21



Installing the LPR (Line Printer Remote) Monitor
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Windows 2000/XP
3 Select Standard TCP/IP Port and click the 

 button.

4 Click the  button.

5 Enter the IP Address and the Port Name and 

click the  button.

Note: The Port Name is automatically 
entered by Windows 2000/XP. You 
may need to change it as required.

New Port ...

Next

Next
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6 Select Custom and click the  

button.

7 1. In the Protocol section, select LPR.
2. In the LPR Settings section, enter the 

Queue Name (e.g. LPR1) and select the 
LPR Byte Counting Enabled.

3. Click the  button.

8 Click the  button.

Settings...

OK

Next

Continued on the next page...
23
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Windows 2000/XP
9 Click the  button.

10 Click the  button.

11 Click the  button.

Click the  button.

The printer properties dialog box closes and 
you have now configured the printer as a 
network printer.

Finish

Close

Apply

OK



Pr
in

te
r S

ec
tio

n

Configuring the Printer Driver Settings

To change the printer settings, open the dialog box for the printer properties by performing the following
steps.

Windows 98/Me

1 Click the Start button, select Settings, and then click
Printers.

2 Right-click on the desired printer icon in the Printers
folder, and select Properties in the popup menu.

The printer properties dialog box appears.
25
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Windows 98/Me

General Tab

1. Comment
Enter comments to the properties, if any.

If another user sets up this printer on his or her computer when sharing the printer, the comment specified
here will also appear on that computer. However, the comment displayed for an existing user will remain
unchanged even if the comment is modified later.

2. Separator page
This feature is not available on your machine.

3.  button
Prints a test page. This allows the user to verify if the printer is installed properly.

Print Test Page
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Details Tab

1. Print to the following port
Displays either the port where the printer is connected or the path to the network printer.

To change the printing destination, either select the printing destination port from the list or enter the
network path here.

2. Print using the following driver
Displays the type of the printer driver. Specify the printer being used or a printer model which can be
emulated with the printer being used.

3.  /  button
Assigns a local port to the network connected printer or cancels a local port assigned to the network
printer.

4. Timeout settings - Not selected
Specify the amount of time (in seconds) allowed to elapse before the printer comes online. If the printer is
not online within this duration, an error message will be displayed.

5. Timeout settings - Transmission retry
Specify the amount of time (in seconds) allowed to elapse before the printer is ready for printing. If the
printer is not ready for printing within this duration, an error message will be displayed.

Increase this value if a timeout error occurs when printing a large document.

6.  /  button
Adds/deletes a new port or a new network path.

7.  button
Updates or modifies the printer driver.

Capture Printer Port... End Capture...

Add Port... Delete Port...

New Driver...
27
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Windows 98/Me

8.  button

Specify the method of sending (spooling) documents from the program to the printer.

• Spool Data Format
Select spool data type (EMF format or RAW format). Specifying RAW format results in a longer time
elapsing before an application becomes operational after printing from it.

Note: Spooling by EMF format (enhanced metafile compression) may cause the following problems on
some application software.

1) Printing result is different from the screen display.
2) Printing requires excessive time.

• Enable bidirectional support
Be sure to check the check box for "Enable bidirectional support" when installing the status monitor.
Otherwise, status information reception may not function properly.

9.  button
Modifies printer port settings.

Spool Settings...

Port Settings...
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Sharing Tab (See Note 1)

1. Not Shared/Shared As
Select whether to display or share this printer with other computers.

2. Share Name
Specify the name of the shared printer. The displayed name can be used as it is or a new name may be
entered. The name specified here will be displayed when other users view information about the printer
on the network.

3. Comment
You can enter comments regarding a shared printer (such as the type of printer and the location where it
is installed). When other users view information about the printer on the network, the comment specified
here will be displayed.

4. Password
Specify the password required when other users will connect to this printer.
Leave the box blank in order not to use any password.

NOTE 1. Sharing Tab in property dialog box is not displayed unless printer sharing has been specified.
29



Configuring the Printer Driver Settings

30

Windows 98/Me

Device Tab (See Note 1)

1. Finisher
Select the type of the finisher if a finisher is installed.

2. Punch Unit
Select Installed if a punch unit is installed.

3. Large Capacity Paper Tray (LCT)
Select Installed if a Large Capacity Paper Tray is installed.

4. HDD
Select Installed if the HDD Unit is installed.

5. Number of Paper Trays
Select the number of available paper trays for the printer if an optional Paper Feed Module is installed.

NOTE 1. Device Tab specifies device-specific settings and settings of optional devices.
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Paper/Output/Quality/Secure Tab 
Refer to All Windows Common Settings (See page 51 - 56).
31
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32
To change the printer settings, open the dialog box for the printer properties by performing the following
steps.

NOTE 1. In Windows NT 4.0, setting the properties depends on the log on account. This section
describes properties to be specified by the administrator (system manager).
See "Configuring the Printer Driver Settings (User)" for details on user properties.  (See page
40)

Windows NT 4.0 (Administrator)

1 Logon to the computer/network using an account with
administrator rights. (See Note 1)

2 Click the Start button, select Settings, and then click
Printers.

3 Right-click on the desired printer icon in the Printers
folder, and select Properties in the popup menu.

The printer properties dialog box appears.
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General Tab

1. Comment
Enter comments to the properties, if any.

If another user sets up this printer on his or her computer when sharing the printer, the comment specified
here will also appear on that computer. However, the comment displayed for an existing user will remain
unchanged even if the comment is modified later.

2. Location
Specifies the printer location.

3. Driver
Displays the printer driver type. Specify the printer being used or a printer model that can be emulated
with the printer being used.

4.  button
Updates or modifies the printer driver.

5.  button
This feature is not available on your machine.

6.  button
Specify the processor to be used for printing (Print Processor) and the data type (Default Data type).

The processor and data type affect the manner in which the printer functions in Windows NT. Normally
they do not need to be modified. However, modification might be necessary when the printer is used with
a special application.

7.  button
Prints a test page. This allows the user to verify if the printer is installed properly.

New Driver...

Separator Page...

Print Processor...

Print Test Page
33
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Windows NT 4.0 (Administrator)

Ports Tab

1. Print to the following port(s)
Displays a list of available ports for printing (Port), their status (Description) and printers that are
connected to these ports (Printer).

2.  /  button
Adds/deletes a new port or a new network path.

3.  button
Configures the selected port. In case of a parallel port, Transmission Retry should be specified. (See
Note 1, 2)

4. Enable bidirectional support
This setting enables reception of configuration data and status data from the printer.

5. Enable printer pooling
Printer pooling allows data sent to one logical printer to be received and printed by two or more printers.
With printer pooling enabled, a transmitted printing job is output to the first printer that is ready for
printing.

NOTE 1. Specify time (seconds) waiting for the printer to be ready for printing. If a printer is not ready for
printing after the specified time has elapsed, an error message is displayed.

2. If a timeout error occurs frequently upon printing a large size document, specify a larger value
here.

Add Port... Delete Port

Configure Port...
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Scheduling Tab

1. Available
Schedules when the printer is available for operation. Specify operating hours when From-To is selected.

2. Priority
Sets printing priority. The slider allows the priority to be adjusted from 1 through 99.

3. Spool print documents... / Print directly to the printer
Specify how documents should be sent from an application to the printer.

4. Hold mismatched documents
The spooler compares document settings against printer settings and holds printing of a document if its
settings (Paper Size, Orientation, etc.) do not match the printer settings.

5. Print spooled documents first
Always prints spooled documents first regardless of printing priority.

6. Keep documents after they have printed
Holds documents in the print queue even after they have been printed. These documents can be printed
again directly from the queue regardless of the state the application is in.
35
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Windows NT 4.0 (Administrator)

Sharing Tab

1. Not Shared/Shared
Select whether to display or share this printer with other computers.

2. Share Name
Specify the name of the shared printer. The displayed name can be used as it is or a new name may be
entered. The name specified here will be displayed when other users view information about the printer
on the network.

3. Alternate Drivers (See Note 1)
Allows other operating systems' printer drivers to be loaded.  When users of these operating systems
connect to the printer, the printer driver is automatically loaded.

NOTE 1. When sharing a printer on the network, the print driver needs to be installed on the print server
only, other computers will automatically copy and use that driver.
For this reason, the print server must be ready with printer drivers for all the operating systems
of all the computers that will be sharing the printer.
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Security Tab (See Note 1) 

1.  button
Set printer access privileges.

2.  button
Displays the users who have used this printer and how they used it.

3.  button
Set the ownership of the printer.

NOTE 1. In order to utilize these features, first you need to select Autid... from User Manager's Policies
and enable File and Object Access in the Audit Policy dialog box.

Permissions

Auditing

Ownership
37
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Windows NT 4.0 (Administrator)

Device Tab (See Note 1)

1. Finisher
Select the type of the finisher if a finisher is installed.

2. Punch Unit
Select Installed if a punch unit is installed.

3. Large Capacity Paper Tray (LCT)
Select Installed if a Large Capacity Paper Tray is installed.

4. HDD
Select Installed if the HDD Unit is installed.

5. Halftone Setup
 button

Select the halftoning method to be used (halftones specific to the printer).
Select it according to the details of the data and your preference.

Halftone Setup...
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• Halftone Pattern
Select the pixel size to be used for halftones.
The greater the value, the coarser the image would become. However, a larger value is suited for
printing large areas.
The Enhanced pattern allows printing at a higher resolution using the same number of pixels. However,
the pattern might generate unnatural lines, patterns, moire effects, and so on depending on the image to
be printed.

• Device Gamma
Adjust the gamma of print images (color intensities).

• Pixel Diameter
Adjust the darkness of the print image. Move the slider to specify the pixel size. You can choose
between specifying the real size in inches or specifying it as a percentage relative to the printer
resolution.

• Luminance (CIE Y)
Adjust the luminosity of the print image.

6. Number of Paper Trays
Select the number of available paper trays for the printer if an optional Paper Feed Module is installed.

NOTE 1. Device Tab specifies device-specific settings and settings of optional devices.
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To change the printer settings, open the dialog box for the printer properties by performing the following
steps.

NOTE 1. In Windows NT 4.0, setting properties depends on the logon account. This section describes
properties to be specified by a user, upon executing a print operation in an application. See
"Configuring the Printer Driver Settings (Administrator)" for details on administrator properties.
(See page 32)

Windows NT 4.0 (User)

1 Select Print in the File menu of the application.

2 Select the printer model in the name list box.

3 Click the  button in the Print dialog box.

4 The printer properties dialog box appears. Click the
desired tabs of the dialog box and specify the properties.
(See Note 1)
(See page 51 - 56)

Properties...
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To change the printer settings, open the dialog box for the printer properties by performing the following
steps.

NOTE 1. In Windows 2000/XP, setting the properties depends on the logon account. This section
describes properties to be specified by the administrator (system manager). See "Configuring
the Printer Driver Settings" for details on user properties. (See page 50)

Windows 2000/XP (Administrator)

1 Logon to the computer/network using an account with
administrator rights.

2 Click the Start button, select Settings, and then click
Printers.

3 Right-click on the desired printer icon in the Printers
folder, and select Properties in the popup menu.

The printer properties dialog box appears. (See Note 1)
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Windows 2000/XP (Administrator)

General Tab

1. Printer Name
Name of the printer specified upon installation is displayed.

2. Location and Comment
Enter a comment about the location of the printer and information about the printer.

If a printer is shared, the location and comments specified in this field appear when another user sets up
this printer on his/her computer. After completion of setup, however, changing this comment does not
update the location and comment appearing on users PCs.

3. Model
Model name of the printer is displayed.

4. Features
Functions and settings of the printer are displayed.

5.  button
Changes properties (print settings) specifiable for each user.
Refer to "Configuring the Printer Driver Settings (User)" for details on settings  (See page 50).

6.  button
Prints a test page. This allows the user to verify if the printer is installed properly.

Printing Preferences...

Print Test Page
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Sharing Tab

1. Not Shared/Shared As
Specify if this printer is displayed or shared with other computers.

For sharing a printer, specify the share name of a printer. A name specified here appears when other
users view the printer information on a network.

2.  button
Install additional printer drivers on the system. (See Note 1)

When users running different versions of Windows share a printer, installing additional drivers avoids the
need for installing new drivers on their systems.

NOTE 1. When sharing a printer on the network, the print driver needs to be installed on the print server
only, other computers will automatically copy and use that driver.
For this reason, the print server must be ready with printer drivers for all the operating systems
of all the computers that will be sharing the printer.

Additional Drivers...
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Windows 2000/XP (Administrator)

Ports Tab

1. Print to the following port(s)
Displays a list of ports that allow printing, their status (description), and printers connected to the ports.

2.  /  button
Adds/deletes a new port or a new network path.

3.  button
Configure the port that is selected. On a parallel port, wait time (in seconds) for retransmission is
specified. (See Note 1, 2)

4. Enable bidirectional support
This setting enables reception of configuration data and status data from the printer.

5. Enable printer pooling
Printer pooling allows data sent to one logical printer to be received and printed by two or more printers.
With printer pooling enabled, a transmitted printing job is output to the first printer that is ready for
printing.

NOTE 1. Specify the time (seconds) waiting for the printer to be ready for printing. If the printer is not
ready for printing after the specified time has elapsed, an error message is displayed.

2. If a timeout error occurs frequently upon printing a large size document, specify a larger value
here.

Add Port... Delete Port

Configure Port...
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Advanced Tab

1. Always available/Available from
Specify the operating schedule for a printer. Selecting Available from allows specifying an available
operation time.

2. Priority
Specify the priority in printing. Priority is adjustable from 1 to 99. Documents of higher priority are printed
before those of lower priority.

3. Driver
Displays the printer driver type. Specify the printer being used, or a printer model that can be emulated
with the printer being used.

4.  button
Updates or modifies the printer driver.

5. Spool print documents so program finishes printing faster
Specify the method of sending a document from the program to the printer.

6. Hold mismatched documents
The spooler compares document settings against printer settings and holds printing of a document if its
settings (Paper Size, Orientation, etc.) do not match the printer settings.

7. Print spooled documents first
Always prints spooled documents first regardless of printing priority.

8. Keep printed documents
After printing, documents are kept in the queue. The documents are allowed to be reprinted directly from
the queue regardless of the status of an application.

New Driver...
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Windows 2000/XP (Administrator)

9. Enable advanced printing features

Enables advanced printing features. Optional features of the printer (page ordering, booklet printing,
numbering on sheets) are enabled. These features can be disabled if a problem occurs due to
incompatibility. Disabling the features may also disable the printing options.

10.  button
Specifies standard (default) values for the properties (print settings) specifiable for each user. If a local
printer is shared, the settings here are used as printing defaults for other users.

Refer to "Configuring the Printer Driver Settings (User)" for detailed settings.  (See page 50)

11.  button
Specify a print processor and data type to be used for printing.

The processor and data type define operations of printers under Windows 2000/XP.

Usually no change is required in the settings. Use of a printer from some applications, however, may
require changes in the settings.

12.  button
This feature is not available on your machine.

Printing Defaults...

Print Processor...

Separator Page...
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Security Tab (See Note 3)

Displays a list of users and groups to whom printer access is assigned to. A list of standard permissions for
each group or user is displayed. Check or uncheck the checkboxes for permitting or prohibiting access.
Gray checkbox indicates the permission inheritance.

1.  /  button
Add or delete a user or group from the list.

2.  button
Specify access to a printer, audit, and owner. (See Note 1, 2)

NOTE 1. Windows 2000 provides the capability of managing access to various objects (e.g. printers) by
users.

2. Refer the Windows 2000 documentation for details on access permission, audit, and owner.
3. The Security Tab is not shown in Windows XP.

Add... Remove

Advanced...
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Windows 2000/XP (Administrator)

Device Tab (See Note 1)

1. Finisher
Select the type of the finisher if a finisher is installed.

2. Punch Unit
Select Installed if a punch unit is installed.

3. Large Capacity Paper Tray (LCT)
Select Installed if a Large Capacity Paper Tray is installed.

4. HDD
Select Installed if the HDD Unit is installed.

5. Halftone Setup
 button

Select the halftoning method to be used (halftones specific to the printer).
Select it according to the details of the data and your preference.

Halftone Setup...
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• Halftone Pattern
Select the pixel size to be used for halftones.
The greater the value, the coarser the image would become. However, a larger value is suited for
printing large areas.
The Enhanced pattern allows printing at a higher resolution using the same number of pixels. However,
the pattern might generate unnatural lines, patterns, moire effects, and so on depending on the image to
be printed.

• Device Gamma
Adjust the gamma of print images (color intensities).

• Pixel Diameter
Adjust the darkness of the print image. Move the slider to specify the pixel size. You can choose
between specifying the real size in inches or specifying it as a percentage relative to the printer
resolution.

• Luminance (CIE Y)
Adjust the luminosity of the print image.

6. Number of Paper Trays
Select the number of available paper trays for the printer if an optional Paper Feed Module is installed.

NOTE 1. Device Tab specifies device-specific settings and settings of optional devices.
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Changes the printer settings. Display the printer settings dialog box by performing the steps below.

NOTE 1. In Windows 2000/XP, setting the properties depends on the log on accounts. This section
describes properties to be specified by a user, upon executing a print operation in an
application. See "Configuring the Printer Driver Settings (Administrator)" for details on
administrator (system manager) properties. (See page 41)

Windows 2000/XP (User)

1 Select Print in the File menu of the application.

2 Select the printer model in the name list box.

3 Click the  button in the Print dialog box. 

4 The printer properties dialog box appears. Click the
desired tabs of the dialog box and specify the properties.
(See Note 1)
(See page 51 - 56)

Properties...
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Paper Tab

1. Paper Size
Select a document size.

2. Copies (1-250)
Specify the number of copies to be printed.  If the number of copies to be printed can be specified within
the application, indicate one copy here and specify the number of copies in the Print dialog box of the
application.

3. Orientation
Select the print orientation (Portrait/Landscape).

4. Output Size
Select an output paper size.

5. Zoom (50-200)
Specify an enlargement or reduction percentage when printing documents.  If enlargement/reduction can
be set within the application, indicate 100% here and specify the enlargement/reduction percentage in
the Print dialog box of the application.

6. Paper Source
Specify where the paper you want to use is located in the device.  If you choose Auto Tray Selection,
the printer driver will automatically select an appropriate tray according to the Paper Size selected.

7. Print Properties Status Icons
Show the print status for the following properties.
• Paper Style (Output Tab)
• N in 1 (Output Tab)
• Sort (Output Tab)

8. Status Monitor
Recalls Network Status Monitor. (See page 134)

All Windows Common Settings

8
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All Windows Common Settings

 Output Tab

1. Paper Style
Select duplex printing for printing on both sides of the paper.
You can select the printing style among 1-Side/2-Sided (Long Edge) /2-Sided (Long Edge Margin) /2-
Sided (Short Edge) /2-Sided (Short Edge Margin).

• Binding Direction
Select the binding side (Long Edge/Short Edge) for duplex printing.

• Binding Margin
Select the binding margin upon duplex printing. The width of the binding margin is specified on the
device.

2. N in 1
Specify the layout pattern for printing multiple documents on a single sheet of paper. 
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3. Sort
Select whether to Stack or Sort when printing multiple copies.
Note: Sort settings made on the printer driver screen have priority.

It is not  recommended to make them on the application screen. 

4. Staple
Select the staple position. Available if the optional Finisher (DA-FS600, FS605, FS330 or FS355) is
installed.

Portrait(Left 1 Position/Left 2/Right 1/Right 2)

Landscape(Left1/Right1/Top)
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All Windows Common Settings

5. Punch

Select the punch position. Available if the optional Punch Unit (DA-SP31) is installed.

You can choose Left/Right/Top regardless of paper orientation.

6. Finisher Bin
You can select the number of the output bin.
Possible when the optional finisher is installed.

7.  Button

• Print All Text as Black (Windows 98/Me only).
All colored text is printed as solid black

• Print Blank Pages
Select whether the blank pages are printed or not.

• Copies
When printing a large amount of data with sort mode, the machine might not be able to print
due to lack of memory capacity.
In this case, select Print Driver controlled, as sorting is processed inside of the printer driver. However,
this mode may take more time to print.

Advanced...
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Quality Tab

1. Halftone (For Windows 98/Me only)
Select either None or Dither.

2. Resolution
Select the print resolution (300 dpi / 600 dpi). (See Note1) 

3. Contrast
Adjust the contrast of print images. (Note: Only if Halftone is set to None.)

4.  button (For Windows NT/2000/XP only)

• Contrast
Adjust the contrast of print images.

• Brightness
Adjust the brightness of print images.

• Dark Picture
Select this option in order to print dark images brighter.

• Negative
Select this option in order to print images with black and white reversed.

• Input RGB Gamma
Adjust the gamma of print images (color intensities). Red, Green and Blue can also be adjusted
individually.

• Black Ref/White Ref
Adjust the difference between the darkest and lightest colors of an image. Increasing the Black Ref
value or decreasing the White Ref value will intensify the contrast of the image but reduces the range of
colors in between.

• Picture
Select a test pattern type.
Selecting the View check box will display halftone adjustment results in the test pattern.

NOTE 1. dpi (dots per inch) represents the number of dots contained in one inch.  The larger the value,
the higher the resolution would be.

 

Halftone Color Adjustment...
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All Windows Common Settings

Secure Tab

1. Mailbox (Available if the optional Hard Disk Drive Unit (DA-HD60) is installed.)
Check this checkbox and enter the User ID (up to 8 digits) when storing the print data into the mailbox of
the machine. 

2. Secure Mailbox (Available if the optional Hard Disk Drive Unit (DA-HD60) is installed.)
Check this checkbox , enter the User ID (up to 8 digits) and the password (up to 4 digits) when storing the
print data into the secure mailbox of the machine. 

3. Dept counter mode On
Check this box and enter the department code if your administrator requires departmental codes in order
to print.
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Print Operation

If the printer driver is installed properly and a printer is selected as the default printer (See Note 1) in the
printer setup, printing can be accomplished from any Windows application with simple operations.

To print from most Windows applications, use the Print... command in the File menu. Selecting the Print...
command typically displays the following Print dialog box:

After selecting the print range to be printed and the number of copies, click on  to start printing.

While documents are being printed, a printer icon appears in the System Tray near the clock on the bottom
right hand corner of the screen. The icon disappears when printing is completed.

You may double-click on the printer indicator in the system tray to open and verify the details of the print
queue in the spooler.

NOTE 1. Follow the steps below to set a default printer:
1) Click the Start button and select Printers in the Settings menu.
2) Select the printer icon in the window and select [Set as Default] in popup menu by right-

clicking it. Then the check mark is displayed.

Printing from Windows Applications

OK
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When sharing a printer by connecting two computers via a crossover cable or using a hub, a connection
among computers must be established. (See Note 1, 2)

Establishing a connection among computers can be verified by displaying the connected computers in
Network Neighborhood on the desktop.

The settings for printer sharing are specified by performing the following steps.

Printer server (PC connected to a printer)

Upon completing this setting, the shape of the icon changes indicating that the printer is shared.

NOTE 1. Refer to the manual for the network card and Windows user's guide for connections among
computers.

2. On Windows 98/Me, a computer connected to a printer must be set up to allow printer sharing
by performing the following operations:
1) Double-click on Network in control panel, and then click  button

in the Configuration tab.
2) Check [I want to be able to allow others to print to my printer(s).] in the File and Print

Sharing dialog box.

Printing on Network

1 Install the printer driver on the computer to be connected
to the machine.

2 Click the Start button, select Settings, and then click
Printers.

3 Right-click on the desired printer icon and select
[Sharing...] in the popup menu.

4 Select Shared As in the properties dialog box.

5 Click the  button.OK

File and Print Sharing...
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Remote (PC that uses another computer's printer)

The operations above enables output from the remote computer to a printer connected to the printer server.

1 Click the Start button, select Settings, and then click
Printers.

2 Double-click Add Printer in the printers folder window.
The Add Printer Wizard appears.

3 Select Network Printer.
Click the  button.

4 Specify the other computer's printer by entering the
network path.

Then, complete the installation following the instructions
of the Add Printer Wizard.

Next
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Document Management System Section

Installing the Document Management System

Windows 98/Me/NT/2000/XP

1 Insert the Panasonic Document Management 
System CD-ROM. (See Note 1 and 2 on page 
63)

2 Select the language.

3 Click the  button.

4 Click Panasonic-DMS.

Note: The Fax Gateway and Firmware Update 
Utility is available in the U.S.A. and 
Canada only.

5 Click Install Panasonic-DMS Software.

Next
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6 Verify the installation destination and click the 

 button.

7 Select your machine's model(s) and click the 

 (Add) button.  

Then, click the  button.

8 Select General User and click the  
button.

Note: If selecting Administrator, the network 
configuration editor and network address 
book editor will also be  installed on your 
PC.

9 Click the Typical button. (See Note 3 on page 
63)

Next

Next

Next

Continued on the next page...
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Windows 98/Me/NT/2000/XP
10 Enter the program folder name and click the 

 button.

11 Click the  button if you want to 

register the Panasonic Communications Utility 
to start with Windows.

12 Click the  button.

13 The required files are copied.

14 <Windows 98/NT only>

Click the  button.

15 When the setup process is completed, a 
message is displayed prompting you to restart 
your computer.

Click the  button to restart your 

computer.

Next

Yes

No

OK

Finish
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The Panasonic Document Management System folder has been added to the Program menu, and the
installation has now completed.

NOTE 1. Before updating the software, be sure to remove the older version of the software, using the
"Add/Remove Programs" shortcut in the Control Panel. 

2 When installing on Windows NT 4.0/2000/XP, logon to the computer using an account with
administrator rights.

3. The Typical installation method installs all of the following drivers and applications.
•Document Manager and Viewer

Document Manager (Image management application)  (See page 64)
Document Viewer (Image editing application)  (See page 82)

•Scanner
Network Scanner (See page 105)

•Network MFP Utilities
Network Status Monitor (Device status monitor)  (See page 134)
Network Configuration Editor/Address Book Editor (See page 145)

•Operating Instructions
Selecting the Custom installation allows to perform selected installation of scanner and MFP
utilities individually.

16 <Windows 98/NT only>
Check [Yes, I accept....] and 

Click on the  button.

Note: After rebooting your PC, the Microsoft 
Data Access Components is also 
automatically installed. Log on to the 
PC with an account rights of 
Administrator when installing on 
Windows NT 4.0.

Click on the  button.

17 Click on the  button.

Next

Next

Finish
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Document Manager

Document Manager is an application for managing documents (image files). By utilizing the Document
Manager and Document Viewer  (See page 82) in combination, a number of documents (image files) can be
classified, managed, browsed, and edited.

Selecting Panasonic → Panasonic Document Management System → Document Manager from
Programs on the Start menu displays the main window of the Document Manager.

1. Title Bar
Displays the title of the screen.

2. Menu Bar
Displays the menus of the Document Manager.

3. Tool Bar
Displays tool buttons of the Document Manager. Tool buttons correspond to functions of the menus in the
menu bar.

4. Folder Window
Displays the folders containing the documents in tree form.

5. Link Icon
Dropping a dragged document onto a link icon will activate the application corresponding to the function
of the icon.

6. Status Bar
Displays information such as the number of documents in a folder, the number of selected documents, file
sizes, etc.

Main Window
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7. Document Window
Displays a list of documents in the selected folder.
Documents are displayed in thumbnails (reduced images). Page number and  and  buttons are
displayed at the bottom of a thumbnail image for grouped documents (configured with two or more
pages).

• Image data files
A thumbnail image of the document is displayed.

• Application data files
A thumbnail image of the document with its original application icon is displayed (i.e. Word, Excel and
PowerPoint).

Clicking on the  and  buttons turns the page to a multi-page document.
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The Document Manager allows editing and managing documents displayed in thumbnail images by
dragging and dropping. The function enables various operations as described below:

Basic Operations

• Selecting Documents
Clicking thumbnail images in the document window allows
selection of documents. Dragging a mouse pointer on the
screen or clicking with the Shift key held down allows
selecting two or more documents at one time.

• Editing Documents
Double-clicking thumbnail images in the document window
activates the Document Viewer (See Note 1)  (See page 82),
allowing opening and editing of documents.

• Creating Documents
Drag-and-drop any application file into the Document
Manager to create a new document. A thumbnail image file is
created and the application icon is displayed.
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• Copying/Moving Documents
Dragging a thumbnail image from the document window and
dropping it onto a folder in the folder window moves the
document to the folder. Drag-and-drop with the Ctrl key held
down to copy a document.

Dragging a document and dropping it onto another document
in a document folder results in grouping the two documents
together.

Dragging a document and dropping it on a link icon activates
an application corresponding to the function of each icon.
Link icons are registered and deleted by selecting Launch
To Another Application → External Application Setup
from the File menu.

• Dragging a document and dropping it onto “Shared Folder”
allows other computers connected to the same network to
access it.
Browse “Shared Folder” for how to create shared folders.
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• Import document (from file)
Selecting Open from the File menu displays a dialog box for selecting files. The dialog box allows
importing image files saved in a computer as documents into the folder.

An attempt to import files that cannot be handled by Document Manager results in displaying an error
shown below. Press OK and verify the file format.

Dragging and dropping a selected document onto a link icon at the bottom of the window activates an
application specified for the link icon, and opens the image file.

The link icons can be Added/Removed by selecting Launch To Another Application → External
Application Setup in the File menu.

The following applications can be specified as destinations of the Document Manager:

- Draw/Graphics software (applications such as MS-Paint, Photoshop etc.)
- OCR software (application such as e-Typist, etc.)
- PC-FAX software
- E-Mail software (MAPI-compatible mail application such as MS-Outlook, Netscape Messenger etc.)
- Others

(Other application documents such as MS-Word, MS-Excel, etc.)

NOTE 1. Document Viewer provides a function to add various graphics and text to an image.
The graphics and text added to an image are called "Annotation." See "Annotation Menu"
(See page 95) for details on annotation.

Setting Plug-in
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File Menu

• New Folder
Create a new folder under the folder that is currently selected.
Path of a folder to be created can be specified as required.

• Shared Folder
Create a new shared folder. Documents in the shared folder
can be shared through the network from different computers.

• Released Shared Folder
Release the shared folder. Documents in the shared folder
will be released from a network.

• Open
A file saved in the computer can be imported into the folder as
a document.

• Save As
A document is saved as an ordinary image file under a
specified name.

• Rename
Change the name of a document.
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File Menu

• Properties

Displays the file properties.

• Backup
Creates a back up of the documents stored in the selected
folder.
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NOTE 1. Print Setup specifies printing or not printing annotations edited in the Document Viewer. See
"Annotation Menu"  (See page 95) for details on annotation.

• Print
Prints the document selected in the document window.

• Print Setup (See Note 1)
Specify layout and printing size for a document to be printed.

1. Horizontal Position and Vertical Position
Adjust the printing position on the sheet.

2. Print Size
Select printing in original size or printing in accordance with
the sheet size.

3. N in 1
Select for printing reduced pages on one sheet.
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File Menu
NOTE 1. See "Setting Plug-in"  (page 68) to specify an external application.

• Launch To Another Application
Opens the document selected in the document window with a
specified application.

Selecting External Application Setup displays a dialog box for
adding/changing/deleting applications. (See Note 1)

Clicking the Add button displays the Add External Application
dialog box.

1. Name
If an external application is specified, the name in this field
appears on the link icon.

2. Application Type
Specify the application type.

3. Program File
Specify the execution file and the path of the application.

4. MAPI Correspondence
Check here if the e-mail application is compatible with MAPI.

5. Parameter
If the e-mail application is incompatible with MAPI, adding a
parameter here allows automatic activation of a transmission
screen.
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• Trash Can
- Open Trash Can

Opens the Trash Can and displays files in it. Selecting

documents and clicking the  button restores
documents that have been discarded.

Click the  button to delete the selected
document.

- Empty Trash Can
Deletes the files in the Trash Can. If the documents are
emptied from the Trash Can, they are permanently deleted.
They are Not stored in the Recycle Bin.

Undo

Delete
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Edit Menu
• Undo

Undoes the last editing operation done.

• Cut
Deletes a selected document from a folder and copy it to the
clipboard.

• Copy
Copies a selected document to the clipboard.

• Paste
Pastes a document from the clipboard into the selected folder.

• Delete
Deletes a selected document from a folder to the Trash Can.
A confirmation message for deletion appears.

• Select All
Selects all documents in the folder.

• Find
Searches for documents by specifying a document name,
creation date, character string or DD Code in the document.

Note: The DD Code Tab is available when the Options Menu
is set to enable the DD Function (See page 78). 
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View Menu
• Tool Bar

Switches between displaying/hiding the tool bar.

• Status Bar
Switches between displaying/hiding the status bar.

• List Format/Thumbnail Format
Switches between list display and thumbnail display in the
document window.

• Show Annotation
Switches between displaying and hiding annotation.

• Arrange Folders
Sorts the document folders by name or date.

• Arrange Document
Sorts the documents in the current folder in the specified order
(Name, Type, Size or Date).

• Lines up Documents
Line up the documents in the document window.

• Refresh
Refreshes the contents of the Document  Manager.
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Document Menu
• Open

Opens a selected document, activates the Document Viewer
(See page 82), and opens the document for editing.

• Duplicate
Makes a copy of the selected document in the folder.

• Rotate
Rotates the selected document.
- Rotate Left
- Rotate 180 Degrees
- Rotate Right

• Group
Makes a group of two or more selected documents. The

grouped documents are indicated by page number and 

and  buttons at the bottom of a thumbnail image.

- Every Document
The selected documents are grouped.

- Every Page Alternately
Groups pages alternately.

- Every Page Reverse Alternately
Groups pages alternately by reversing the pages.
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• Ungroup
Cancels the grouping for grouped documents. Either dividing
all pages into individual documents or releasing only specified
documents from a group can be selected.

• Enhancement
Applies the following correction to a selected document:

- Correct Skew
Detects any inclination of the document and automatically
correct it.

- Enhance Edge
Enhances edges (borders) of images.

- Eliminate Noise
Removes noise on the document.

- Reverse Gradation
Displays images in reverse.

• Page
Selects pages to be displayed in thumbnail among grouped
documents.

Selecting Rearrange Page displays the Rearrange Pages dialog
box. The order of the pages are changed by selecting, dragging
and dropping the pages.
Click the Reverse Order button to reverse the page order.

• Attached File
Opens a dialog box to launch the application associated with
the selected attachment.

• File Conversion
Creates an image of the selected attachment.
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Options Menu

• Setup
Selects the expansion feature(s) to be available on the
Document Manager.

To enable the expansion feature for DD Server Software, select

DD Function and click the  button.

Select the data folder (DD Folder) on the server.

• [Options] - [DD Function] - [Print DD Cover]
Prints the DD Cover page selected in the document window
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Image Converter

Once Panasonic-DMS has been installed, the Panasonic Document Manager (Image Converter) is
automatically installed in the Printers folder. This driver is for rasterizing application files such as from Word
or Excel, and for placing them in the Document Manager.  To change the default properties,  follow the
instructions below:

1. Click the Start button, select Settings, and then click Printers.

2. Right-click on Panasonic Document Manager and select Properties from the popup menu.
The Properties dialog box appears.

3. Click the  button to save the settings and close the Properties dialog box.

General Description

Windows 98/Me

• Paper/Layout tab

- Paper Size
Sets the document paper size.

- Orientation
Sets the document orientation.

- Resolution
Sets the document resolution.

• Quality tab

- Color
Sets the document color conversion to color or
monochrome.

- Monochrome
Select Normal (Black and White) or Grayscale (Photo) when
converting to monochrome. Also sets the brightness and
contrast. 

OK
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1. Click the Start button, select Settings, and then click Printers.

2. Right-click on Panasonic Document Manager and select Document Defaults from the popup menu.
The Document Properties dialog box appears.

3. Click the  button to return to the Printers folder.

Windows NT 4.0

• Page Setup Tab

- Paper Size
Sets the document paper size.

- Orientation
Sets the document orientation.

- Color Appearance
Sets the document to color or grayscale.

• Advanced Tab

- Paper Size
Sets the document paper size.

- Orientation
Sets the document orientation.

- Resolution
Sets the document resolution.

- Color Appearance
Sets the document to color or grayscale.

- Metafile Spooling

- Halftone Color Adjustment

OK
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1. Click the Start button, select Settings, and then click Printers.

2. Right-click on Panasonic Document Manager and select Printing Preferences from the pop-up menu.
The Printing Defaults dialog box appears.

3. Click the  button to return to the Printers folder.

Windows 2000/XP

• Layout tab
Sets the document orientation.

• Paper/Quality tab
Sets the document to color or grayscale.

• Advanced button
Sets the paper size, resolution, and spooling properties.

OK
81



82
Document Viewer

The Document Viewer is an application for editing documents (image files) to be managed with the
Document Manager  (See page 64). In addition to usual image editing, the program provides various editing
capabilities for documents with a wide selection of annotation functions.

Double-clicking on the document (thumbnail) in the Document Manager screen or selecting Open in the
Document menu displays the main window of the Document Viewer. (See Note 1)

NOTE 1. The program can be also activated by selecting Panasonic → Panasonic Document
Management System  → Document Viewer from Programs in the Start menu.

Main Window
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1. Title Bar
Displays the title of the screen and the name of the image file being displayed.

2. Menu Bar
Displays the menus of the Document Viewer.

3. Tool Bar
Displays tool buttons of the Document Viewer. Tool buttons correspond to functions of the menus in the
menu bar.

4. Page List
Displays the pages of the documents as thumbnails (reduced image).

5. Size Bar
Adjusts the scaling of the display on the image window.

6. Link Icon
Dragging and dropping a document on a link icon activates the application corresponding to each icon.

7. Status Bar
Displays information such as image file name, image type, and size.

8. Image Window
Displays the image and annotations of the pages being selected.

9. Ruler
Displays the actual size of an image that is selected. The unit of measurement can be switched by
Detailed Settings ...→ Ruler Unit in the View menu.
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Basic Operations
• Selecting Page

Selecting a page, by clicking it in the page list, displays an
image of the selected page on the image window.

Dragging and dropping a page within the page list can change
the order of the pages.

• Image Editing
The image displayed in the image window can be edited with
the menu below:

- Edit menu 
Editing operations such as cutting, copying, pasting, and
adding annotations.

- Page - Adjust Page menu 
Image correction and color balance adjustment of the whole
page.

• Selecting Area
Dragging the mouse on the image window allows to select a
specific area in an image. This function is used to save a
specified area or to specify an area for annotation.
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Document Viewer provides functions to add various graphics and text to an image. The graphics and text
added to an image are called <Annotation>.

The annotation function, unlike those in usual image editing applications, does not change the image itself
but lays graphics and text on the image. Annotations and the original image are displayed as one image.

Annotations are managed separately from image data. Therefore, the Document Viewer can switch
between displaying and hiding annotations.

If an image is edited with the Document Viewer, and is exported (sent) to another image editing application,
it can be sent with the annotation to the image or not.

Annotation Function

Annotation Original image Annotation added
to the original image
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File Menu
• Open

Opens an image file saved in the computer.
Files of the following formats can be opened on the Document
Viewer.

- TIFF
Tagged Image File Format (TIFF).

- JPEG 
Joint Photographic Experts Group (JPEG) format.

- BMP 
Windows standard bitmap format.

- PNG
Portable Network Graphics format.

- DDM
Document Manager file format.

• Save (See Note 1)
Saves a document being edited.

• Save As (See Note 1)
A document is saved as an ordinary image file under a specified
name.

- All page(s)
Saves all pages in the document.

- Select page
Saves only the selected page.

- Specified area
Saves only the portion specified in the image window.

Document Viewer saves a file in the following formats:

- TIFF
Tagged Image File Format (TIFF).

- Multi-page TIFF
Multipages Tagged Image File Format (TIFF).

- Internet Fax TIFF
Tagged Image File Format (TIFF) with Internet Fax format.

- JPEG 
Joint Photographic Experts Group (JPEG) format.

- BMP 
Windows standard bitmap format.

- PNG
Portable Network Graphics format.

- PDF
Adobe Portable Document Format (PDF).

- DDM
Document Manager file format.
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NOTE 1. When saving a document with annotations, save the document in the Document Manager file
format (DDM). This format saves the annotations and image data separately (as objects) so
that they can be edited later. Although saving a document in another format allows further
editing, the annotations cannot be undone. They will be merged into the file.

• Print
Prints a document under the editing operation. For a document
containing two or more pages, pages from-to can be specified
for printing.

• Print Setup
Specifies the layout, printing size, and printing of annotations for
a document to be printed.

1. Vertical position and horizontal position
Adjusts the printing position on the sheet.

2. Print Size
Select printing in original size or printing in accordance with
the sheet size.

3. N in 1 printing
Select for printing two or more reduced pages on one sheet.
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File Menu
NOTE 1. See "Setting Plug-in"  (page 68) to specify an external application.

• Launch To Another Application
Opens the document selected in the document window with
a specified application.

Selecting External Application  (See Note 1) displays a dialog
box for adding/changing/deleting applications.

Clicking the Add button displays the Add External Application
dialog box.

1. Name
If an external application is specified, the name in this field
appears on the link icon.

2. Application Type
Specify the application type.

3. Program File
Specify the execution file and the path of the application.

4. MAPI Compliant
Check here if the e-mail application is compatible with
MAPI.

5. Parameter
If the e-mail application is incompatible with MAPI, adding
a parameter here allows automatic activation of a
transmission screen.
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• Trash Can
- Open Trash Can

Opens the Trash Can and displays any page in it.

Selecting page and clicking the  button
restores page that has been discarded.

- Empty Trash Can
Deletes the pages in the Trash Can. If a page is emptied
from the Trash Can, it is permanently deleted. it is  Not
stored in the Recycle Bin.

Undo
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Edit Menu
• Undo

Undoes the last editing operation done.

• Cut
Deletes a selected annotation from a folder and copies it to
the clipboard.

• Copy
Copies a selected annotation on the clipboard.

• Paste
Pastes an annotation from the clipboard into the selected
page.

• Clear
Clears a selected annotation.

• Select All
Selects all annotations on the selected page.
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• Drag Mode
Sets to the Drag Mode.

• Clip Mode
Sets to the Clip Mode.

• Edit Mode
Sets to the Edit Mode.

• Zoom In
Zooms in on an image.

• Zoom Out
Zooms out on an image.

• Fits to Page Width
Fits the display to the page width.

• Fits to Page Height
Fits the display to the page height.

• Full Page
Fits the display to the full size page.

• Original Size
Returns the display to the original size.

• 25% - 200%
Shows the display at 25% - 200%.

• Detailed Settings
Sets detailed settings, such as thumbnail or page image settings.

View Menu
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Page Menu
• Next

Displays the next page.

• Previous
Displays the previous page.

• Top
Displays the top page.

• Last
Displays the last page.

• Select
Displays a specified page.

• Auto Paging
Turns the pages automatically.
- Move Forward

Automatically steps through pages forwards.
- Move Backward

Automatically steps through pages backwards.
- Stop

Stops automatic page advance.
- Setup 

Sets automatic page advance.

• Move page
Moves pages to the desired position.
- Next page

Moves the current page to be after to the next page.
- Previous page

Moves the current page to be before to the previous page.
- Top page

Moves the current page to be the top page.
- Last page

Moves the current page to be the last page.
- Select page

Moves the current page to the page you specified.

• Delete Page
Deletes the current page.

• Copy Page
Copies the current page.

• Add Page
Adds new pages from file to documents.
Adds new pages from Twain scanner to documents.
(The Twain Mode is not available in these models)
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NOTE 1. Grayscale and color information of a grayscale or RGB color image will be lost upon
conversion into a monochrome image. The lost information is not restorable.

2. Color information of a RGB color image will be lost upon conversion into a grayscale image.
The lost information is not restorable.

• Insert Page
Inserts a page from file at the current position.
Inserts a page from Twain scanner at the current position.
(The Twain Mode is not available in these models)

• Replace Page
Replaces the current page from file with a new page.
Replaces the current page from Twain scanner with a new
page.
(The Twain Mode is not available in these models)

• Rotate Page
- Rotate Right

Rotates the page 90 degrees clockwise.
- Rotate 180 Degrees

Rotates the page 180 degrees
- Rotate Left

Rotates the page 90 degrees counterclockwise.

• Adjust Page
- Correct Skew

Adjusts orientation.
- Eliminate Noise

Eliminates the noise.
- Enhance Edge

Enhances the edge.
- Brightness/Contrast

Adjusts brightness or contrast.
- Hue/Chroma

Adjusts hue or chroma.
- Reverse Gradation

Reverse Gradation.
- Monochrome (See Note 1)

Converts to Monochrome.
- Grayscale (See Note 2)

Converts to Grayscale.
- RGB

Converts to RGB full color.
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Page Menu

• Copy Page to Clipboard

Copies the entire page selected onto the clipboard.

• Copy Select Area
Copies select area to clipboard.

• Select All Pages
Selects all pages.
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Annotation Menu
• Show Annotation

The check box on/off setting specifies whether to display an 
annotation in the page list thumbnail.

• Set Annotation
Protects the annotation from re-editing.

• Annotation Order
- Change Order To Top
- Change Order To Last
- Change Order To Previous
- Change Order To Next

• Create Annotation
- Text

Creates a text annotation and pastes it to a page.
- Line

Creates a line annotation and pastes it to a page.
- Rectangle

Creates a rectangular annotation and pastes it to a page.
- Ellipse

Creates an ellipse annotation and pastes it to a page.
- White block

Creates a white rectangular (solidly white-painted) annotation 
and pastes it to a page.

- Black block
Creates a black rectangular (solidly black-painted) annotation 
and pastes it to a page.

- Marker
Create a marker annotation and pastes it to a page.

- Label
Creates a label annotation and pastes it to a page.

- Stamp
Creates a stamp annotation and pastes it to a page.

- Date
Creates a date annotation and pastes it to a page.

- Page No.
Creates a page number annotation and pastes it to a page.
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Annotation Menu

• Header

Edits a header common to each page.

• Footer
Edits a footer common to each page.

• Edit Text
Sets a format of the text in a selected annotation.

• Properties
Displays annotation properties.
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Annotation Menu

NOTE 1. To specify text font and colors, select the drawn text and select Properties in the Annotation
menu. The Text Format Setup dialog box can be displayed also by selecting Properties in the
pop-up menu, that appears by right-clicking on a drawn text.

2. To specify the thickness and color of a line, select a drawn line and then select Properties in
the Annotation menu. Graphics Format Setup dialog box can be displayed also by selecting
Properties in the pop-up menu, that appears by right-clicking on a drawn line.

3 To specify the thickness and colors of the rectangle, select the drawn rectangle and select
Properties in the Annotation menu. The Graphic Format Setup dialog box can be displayed
also by selecting Properties in the pop-up menu, that appears by right-clicking on a drawn
figure.

• Text
Creates a text annotation. Select text annotation in the
annotation menu (or tool button), and drag the mouse in the
image window to specify the display position.
A dialog box for text setup will appear.
Enter the text to display, and then specify text color and font.
(See Note 1)

• Line
Creates a line annotation.
Select line annotation in the annotation menu (or tool button
(See Note 2)), and drag the mouse in the image window to
draw lines.

• Rectangle
Creates a rectangle annotation.
Select rectangle annotation in the annotation menu (or tool
button (See Note 3)), and drag the mouse in the image
window to draw a rectangle.
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Annotation Menu
NOTE 1 To specify the thickness and colors of the ellipse, select the drawn ellipse and select
Properties in the Annotation menu. The Graphic Format Setup dialog box can be displayed
also by selecting Properties in the pop-up menu, that appears by right-clicking on a drawn
figure.

• Ellipse
Creates an ellipse annotation.
Select ellipse annotation in the annotation menu (or tool 
button (See Note 1)), and drag the mouse in the image 
window to draw an ellipse.
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NOTE 1. To specify lines and colors of solid white, select the drawn solid white rectangle and select
Properties in the Annotation menu. The Graphic Format Setup dialog box can be displayed
also by selecting Properties in the pop-up menu, that appears by right-clicking on a drawn
figure.

2. To specify lines and colors of solid black, select the drawn solid black rectangle and select
Properties in Annotation menu. The Graphic Format Setup dialog box can be displayed also
by selecting Properties in the pop-up menu, that appears by right-clicking on a drawn figure.

• White Block
Creates a white rectangle (solidly white-painted) annotation.
Select white annotation in the annotation menu (or tool button
(See Note 1)), and drag the mouse in the image window to
draw a white rectangle.

• Black Block
Creates a black rectangle (solidly black-painted) annotation.
Select black annotation in the annotation menu (or tool button
(See Note 2)), and drag the mouse in the image window to
draw a black rectangle.
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Annotation Menu
NOTE 1. To specify the color of a marker, select the drawn marker and select Properties in the
Annotation menu. The Graphic Format Setup dialog box can be displayed also by selecting
Properties in the pop-up menu, that appears by right-clicking

2. To specify the color and font of a label, select the drawn label and select Properties in the
Annotation menu. The Graphic Format Setup dialog box can be displayed also by selecting
Properties in the pop-up menu, that appears by right-clicking on a drawn label.

• Marker
Creates a marker annotation.
Select marker annotation in the annotation menu (or tool
button (See Note 1)), and drag the mouse in the image
window to draw a marker.

• Label
Creates a label annotation.
Select label annotation in the annotation menu (or tool
buttons (See Note 2)), and drag the mouse in the image
window to draw label displays Text Format Setup dialog box.
Enter text to display and specify text color and font.



Document Viewer

Annotation Menu

D
oc

um
en

t M
an

ag
em

en
t 

Sy
st

em
 S

ec
tio

n

• Stamp
Creates a stamp annotation.
The stamp annotation pastes another image file like a stamp.
Select stamp annotation in the annotation menu (or tool

button) and click the  button. Then  drag the
mouse in the image window to specify the area, displaying the
stamp dialog box.

Click the  button to specify an image from a file.

Clicking the  button allows to select image files to
be used as a stamp.

OK

Browse

Add
101



Document Viewer

102

Annotation Menu
NOTE 1. To specify the color or font of the date, select the drawn date and select Properties in the
Annotation menu. The Text Format Setup dialog box can be displayed also by selecting
Properties in the pop-up menu, that appears by right-clicking on a drawn figure.

• Date
Creates a date annotation.
Select date annotation in the annotation menu (or tool
button), and drag the mouse in the image window to specify
the area, displaying the Properties dialog box.
Specify the format, color, and font of the date to be displayed.
(See Note 1)

1. Font Name
Specify the font here.

2. Style
Specify the font style.

3. Size
Specify the font size.

4. Text Color
Select the text color here.

5. Date
Specify the date here. Selecting from the calendar or
entering the date.

6. Format
Specify the display format here.

7. Text Align
Specify the text alignment.
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• Page No.
Creates a page number annotation.
Select page number annotation in the annotation menu (or
tool button), and drag the mouse in the image window to
specify the area. Double-click the Page No area to display the
text the settings dialog box.
Specify format, color, and font of the page number to be
displayed.

1. Font Name
Specify the font here.

2. Style
Specify the font style.

3. Size
Specify the font size.

4. Text Color
Select the text color here.

5. Text Align
Specify the text alignment.

Opens the Graphics Format Setup Dialog box.
Click on the drawn figure and select Properties to change the
thickness and colors of the lines.

1. Line Width
Specify the thickness of the lines here.

2. Line Style
Specify the types of lines here

3. Line Color
Specify the color of the lines here.

4. Fill Color
Select the color for solid painting here.

5. Semitransparent
Set the image to transparent.

6. Arrow Style
Select the Arrow style.
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• Main Tool Bar
Show/hide main toolbar.

• Page Tool Bar
Show/hide page toolbar.

• Annotation Tool Bar
Show/hide page adjustment toolbar.

• Image Tool Bar
Show/hide page adjustment toolbar.

• Status Bar
Show/hide status bar.

• Page List
Show/hide page list.

• Ruler
Show/hide ruler.

• Plugin
Show/hide plug-in.

Window Menu
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Network Scanner

Startup Windows, and select Panasonic → Panasonic Document Management System → Panasonic
Communications Utility in Programs from the Start menu.
The Panasonic Communications Utility is activated and the icon appears on the Task Bar.

� Scanner reception notification
Select the Scanner reception notification either Pop up Display or Icon Display.

<Pop up Display>
Displays the following message when the scanner image is received.

<Icon Display>
Changes the Status Monitor icon when the scanner image is received.

� Scanner Configuration
Right-click on the icon and select Scanner Configuration....

Network Scanner Settings
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Network Scanner Settings

The Scanner Configuration Window appears as shown below.

• Launch application
Select the application among Document Manager / Windows Explorer / Other Application that will receive
the scanner data.

• Application
Select the application program path to open the scanned image.

• Save As File Type
Select the file type to save the scanned image.

• Save To
Select the path to save the scanned image.

• Scanner reception notice
Select the view mode of the scanner reception notice.

<Address Information>
Select one of the following:

Auto Registration - The information below will be automatically registered in the Address Book of the
device(s).

Manual registration at scanner -The Address Book of the device will be used to enter the computer's
address manually.

• Name
Set the PC Name (See Note 1) to be saved to the machine.

• Key Name
Set the Key Name (See Note 1) to be saved to the machine.

• Group ID
Set the Group ID  (See Note 1) (1 -99).

• Address Renewal Interval
Set the period to update the address information to the machine.
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Panasonic Communication Utility
Right-click the Panasonic Communication Utility icon on the Task Bar.
The Panasonic Communication Utility Window appears as shown below.

Set the activate program when double-clicking the Panasonic Communication Utility Icon.

� Scanner Configuration
Open the Scanner Configuration Window.

� Fax Receive Log
Open the Fax Receive Log Window.
Exit the Panasonic Communcation Utility.

� Other

Click the  button to set the application program.

NOTE 1. See page 103 on the Operating Instructions for Copier & Network Scanner for details.

Panasonic Communication Utility

Browse
107



108
Panafax Desktop

Panafax Desktop is a PC Faxing application specifically designed to compliment the Panasonic line of
multi-function products

Document(s) created on the PC can be easily faxed to a remote location directly, without having to print a
hard copy first and then using the fax machine to send. This improves the copy quality received at the
remote location, saving the cost and time of printing the hard copy locally before faxing it.
• Compatible Models

- DX-600 / 800
- DP-3510 / 4510 / 6010 with Fax and I-Fax Options

There are two types of Panafax Desktop configurations, Simple Send Only System and Send & Receive
Network Shared System.

*1: The result of the Simple Send Only System transmission, the Send Log and TX Confirmation Notice
indicates only the transfer to the device. It confirms whether it reached the final destination with a Job
Completion Notice of the Status Monitor. Please refer to the Status Monitor section for more details. 

*2: A transmission result is reflected on the Send Log and TX Confirmation Notice with the Send & Receive
System.

Simple Send Only System Connection Diagram

General Description

Connection Configuration

Device Setting PC Fax Setting
Simple Send Only System

• Peer To Peer Connection
• SMTP Email Server Not

Required

• IP Address settings
• Relay XMT Password setting
• Relay XMT Report = Invalid setting*1

• Relay XMT Password setting

Send & Receive System
• Shared Network Connection
• SMTP Email Server and RX

Email Account Required

• IP Address settings
• Relay XMT Password setting
• Relay XMT Report = Valid setting*2
• I-Fax setting
• Fax Forward setting

• For the Server PC
- Email Address settings
- Relay XMT Password setting
- Server setting
- POP Receive setting for the

Client PC
- Search Shared Server setting

aaa bbb

aaa bbb

Transfer Fax Data

Transmit

Send FAX
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Send & Receive Shared Network System Connection Diagram

aaa

ccc

ccc

bbb

ddd

ddd

Client

Client

Client

Client

Transfer Fax Data Transfer
Fax Data

View Shared Folder

POP Receive

Transmit

Receive

Send FAX

Receive FAX

Fax Forward
LAN

Server

Server

Email
Server

Email
Server
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Panafax Desktop uses the fax modem in the Panasonic/Panafax models connected on your network (LAN)
for fax communication. 
Before using the Panafax Desktop, it is necessary to activate the Fax Modem and to setup certain
parameters. Follow the steps below to setup the Panafax Desktop.

Installation

Installation and Setup of Panafax Desktop

1 Confirm the following device settings. 
• Common settings:

- Connection to the Network
- Setup the IP Address setting
- Setup the Relay XMT Password

• Send Only System settings:
- Set the Relay XMT Report = Invalid (Fax Parameter No. 143)

• Send & Receive System settings:
- Set the Relay XMT Report = Valid (Fax Parameter No. 143)
- Set the Fax Forward to Receive Email Account (Fax Parameter No. 054)

2 Install the Document Management System.
Refer to Page xx
Note: 
For the DP-3510/4510/6010, the Panafax Desktop does not install automatically with the TYPICAL installation.
Select CUSTOM installation and check the Panafax Desktop to be installed.
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Basic Setup (Send Only System /Send & Receive System)

1 Double-click the  icon on the Windows Desktop.

The Panasonic Communications Utility appears.

Click the  button.

2 Device Search Ranges appears.

Click the  button to start searching for the 
Network Connected Devices.

Note: 1 It searches for all the devices within 
the default Subnet. Refine the 
search range when there are many 
devices connected in the Subnet, or 
you want to connect to devices 
outside of the Subnet. To change 

the search range, click  
button and specify the range.

OK

Search Now

Add

Continued on the next page...
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Installation and Setup of Panafax Desktop
3 Starts searching for the PC Fax devices on the network.

4 The Network connected PC Fax device(s) are listed in the 
PC Fax Device Locator.
Select the desired Device and double-click or Click on 
Properties from the Device menu.
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5 The PC Fax Properties appears.
<General> Tab

• Input the PC Fax Settings.
- Device's Email Address

Send Only System:
Set a dummy Email Address. 
(e.g. dummy@dummy.com)
Send & Receive System:
Set the Email Address of the device. (See Note 1)

- Device's Relay XMT Password
The Relay XMT Password of the device.

- Result Report Email Address
Send Only System:
Set a dummy Email Address. 
(e.g. dummy@dummy.com)
(See Note 2)
Send & Receive System:
Set the Email Address for the reception.

Note:
1 Only the Email forwarded to the receiving account 

from this Email Address will be received. Input it 
precisely, otherwise it will not receive if the Email 
address doesn't match.

2 If you have your own Email Address and your 
device is set up for the Internet Fax setting, set 
your Email Address here. You can receive the 
Result Report from the device.

<Transmission/Reception> Tab
• Transmission Setting

- Transmission Priority
If there are multiple devices available, you can set 
the Transmit Propriety of the device.

- Dept counter mode On
When the Department Code function is being used 
at the device, check the box and input the 
Identification Code

- Start Status Monitor at sending
Starts Status Monitor automatically at sending. 
When the device completes transmission, the Status 
Monitor displays the Job Completion Notice.

• Reception Setting (Send & Receive System only)
- Makes Reception Effective

Check this box if you want to do reception with this 
device.

• Acquires Phone Book data from the device
- Device's Password

Device's Password to acquire the phone book data 
from the device, it is required to set the same 
password as the Password of the device. 

Note:
1 The DX-800 uses Remote Password.
2 A blank Remote Password on the DX-800 is the 

same as 0000.

Click on  when you finish inputting the 

settings.

OK

Continued on the next page...
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Installation and Setup of Panafax Desktop
6 Confirm that the device's Condition is in Standby (It takes 
a little while) using the PC Fax Device Locator.

Click  or select Device | Exit from the menu to close 
the PC Fax Device Locator.
For the Send Only System, the setup is completed.
For the Send & Receive System, continue to the 
Receive Setup on the next section. 

x
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Receive Setup (Send & Receive System only)

1 Click  icon on the Windows Desktop.

The Panafax Desktop appears.
Select Tools | PC Fax Device Locator from the main 
menu.

2 The PC Fax Device Locator appears.
Select Device | Detail Settings from the menu.

3 The Detail Settings appears.
• Fax Log Data Folder

- Location
Specify the location to save the Fax log data. The 
default setting is generally acceptable.

• Shared Server Settings
- The Shared and Account Name 

Set up when Panafax Desktop is used in shared 
mode.

• POP Server Settings for PC Fax Reception
This is set up when Panafax Desktop uses the 
Receive function.
POP Server settings and the receiving Email 
Account.

• PC Fax Transmit Setting
- Max. number of Multi-Station TX

Setup the maximum number of destinations    to 
transmit to during one transmit request to    a 
device. 
If the number of the destinations exceed this 
number, it will be divided into more than one 
transmission. When it is divided into several 
transmissions, and there are other devices 
available, it will transmit a request to multiple 
devices.

Click on ,when you finish inputting the 

settings.
Note: If your PC is running Windows NT/2000/XP and 

the client PC is running Windows 98/Me, it is 
necessary to use the Guest Account to use the 
Fax Server function. If a message comes up "Do 
you want to use the Guest Account?" click [Yes] 
to use the Guest Account.

OK

Continued on the next page...
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Installation and Setup of Panafax Desktop
4 Select Device | Detail Settings from the menu.

5 The PC Fax Properties appears.
Click Transmission/Reception tab and check the 
"Makes Reception Effective" box.

Click .

6 Confirm that the Reception status displays "Yes". It 
takes a moment.
The Send & Receive System setup is completed.

OK
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Client Setup (Send & Receive System)

1 Click  icon on the Windows Desktop.

The Panasonic Communications Utility appears.

Click the  button.

2 Device Search Ranges appears.
Click on the [Shared Network Connected Device(s)] 
radio button.

Click the ] to start searching the shared 
Server.

Note: Searching time sometimes may take a long time 
when there are many PCs connected to your 
network. In this case, we recommend you to click 
[Add] button and specify the Domain or 
Workgroup, or specify the Computer Name 
directory to reduce the searching time.

Look in
• Specified Domain or Workgroup

Input device's Domain or Workgroup.
• Specified Computer Name

Input the Server Computer Name.
• Shared Name

Input the Server Shared Name if you changed 
from the default setting.

• Password
Input the Server Password if you changed from 
the default setting.

OK

Search Now

Continued on the next page...
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Installation and Setup of Panafax Desktop
3 Start searching the Server for Network connected 
Devices.

4 The Network connected device via Server is listed in 
the PC Fax Device Locator.
The reception function is Yes if the shared device's 
reception function is effective. If you do not wish to 
receive fax, select the Device and double-click or Click 
Device | Properties from the menu.

5 The PC Fax (Shared Device) Properties appears.
Click Transmission/Reception tab and checkout a 
box of "Makes Reception Effective".

Click .

6 Confirm the Reception becomes No.
It takes a little while.

OK
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Sending a Document via Windows Application
You can send a fax directly from any Windows Application by simply printing to the Panafax Desktop Driver.
For example, compose a document from your word processor application. When you are finished and ready
to fax it to a remote location, simply follow the procedure below.

Sending Document

1 From the current Application select Print from the File 
menu.

2 The Print dialog box appears.

Select Panafax Desktop Driver from the Printer Name 
menu.

Click the  button to convert the document 

into a Fax image.

3 Enter the recipient's Fax No., Name and Company or 
select your Personal Phone Book.

Click the  button to enter the recipient to the recipient 
list.
Enter/select another recipient if you desire.
Type the Subject in the Subject field and a brief message 
to be included in the Cover Sheet.

OK

Continued on the next page...
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Sending Document
4
Click on  the  button when ready to send the fax.

5 Click on  the  button to start the 

transmission.

6 If you check the Transmission Result Report, it will 
display the Transmission Result Report after transmission 
completed. 

If you start Status Monitor (see section of the Status 
Monitor), it will display the Job Completion Notice after 
transmission completed.

Note: The status Monitor can be started automatically at 
sending by the Transmission/Reception Tab of Basic 
setting.

OK
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Sending a Document via the Panafax Desktop
You can send a fax directly the file made any Windows Application by simply opening the file via the
Panafax Desktop.
For example, compose a document from your word processor application. When you are finished and ready
to fax it to a remote location, simply follow the procedure below.

1 Click  icon on the Windows Desktop.

The Panafax Desktop window appears.

Click on the  button to select a file for the 

transmission.

2 Select the file and click the  button to 

convert the document into a Fax image.

3 From the Panafax Desktop window, enter the 
recipient's Fax No. , Name and Company or select 
from your Personal Phone Book.

Click the  button to enter the recipient to the 
recipient list.
Enter/select another recipient if you desire.
Type the Subject in the Subject field and a brief 
message to be included in the Cover Sheet.

Click on  the  button when ready to send the 

fax.

4 Click on  the  button to start the 

transmission.

Open

OK
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Sending Document

Sending a fax memo by Panafax Desktop

You can send a fax memo directly from the Panafax Desktop. This memo can be sent quickly and easily.

1 Click  icon on the Windows Desktop.

The Panafax Desktop window appears.

2 From the Panafax Desktop window, enter the 
recipient's Fax No. , Name and Company or select 
from your Personal Phone Book.

Click the  button to enter the recipient to the 
recipient list.
Enter/select another recipient if you desire.
Type the Subject in the Subject field and a brief 
message to be included in the Cover Sheet.
If you wish, click Cover Sheet to change the Cover 
Sheet Type.

3
Click on  the  button when ready to send the 

fax.

4 Click the  button to start the transmission.OK
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Receive Setting

Receiving Document

1 Confirm the Panasonic Communications Utility icon is 
in the task tray.

2 Right-click the Panasonic Communications Utility Icon 
to show the menu and select the PC-Fax Reception 
Notification.

• Popup Display
• Icon Display
• No Notice

When a fax is receive on the machine, it will proceed as follow:

1 A receiving notice appears on the connected PC.

Click the  button.

or

The Panasonic Communications Utility icon is 
changed. 
Double click the icon.

2 The Receive Log appears.
Select a transaction from the log then click the 

 button to view the received fax.

3 The received fax is shown on the PC.

Receiving LOG
123



Panafax Desktop

124
Registering the Personal Phone Book
To register a recipient to the Personal Phone Book, follow the steps below:

1 Click on the  button to open the Phone Book 

dialog Box.

2 Click on the  button.

3 <Contact> Tab
• Name:

Enter the recipient's name.
• Fax No.:

Enter the fax number.
• Call Type:

Select how the call should be dialed.
The code set up with Tools/Setup/Dialing Settings 
is dialed at the head of the fax number.

4 <Data Field> Tab
Enter the Company Name, Department Name, Job 
Title, Address, Direct Phone No. and the Extension 
Phone No. of the recipient to be used on the Cover 
Sheet.

5 Click the  button to save the entry.

To add another entry, repeat from the step 2.

OK
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To register a group of recipients, follow the steps below:

1 Click the  button.

2 The Phone Book dialog box appears.

Click the   button.

3 The Group Registration dialog box appears.

Click the  button.

4 The Add New Group Name dialog box appears.

Enter the group name and click  button.OK

Continued on the next page...
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Registering the Personal Phone Book
5 Select the desired recipients.

6 Click the  button to add the recipient(s) to 

the Member List.
To add another group, repeat from step 3.

If finished, click  button to exit Group 

registration.

To register a group of recipients, follow the steps below:

OK
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The Cover Sheet is attached to the first page of every fax and contains information such as the recipient's
name, sender's name, date, title, etc.

Creating Cover Sheet

Cover Sheet

1 Click the  button.

2 The Cover Sheet Editor window appears. 
Edit the Cover Sheet.
Select Save As from the File menu.

3 The Save as dialog box appears.
Select the Folder you wish to save, or
if you wish to save into the New Folder,

click  button,
enter the New Folder Name,

and then click .OK

Continued on the next page...
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Cover Sheet
4 Enter the New Folder Name into the Cover Sheet File 
Name box.
Enter comments into the Comment box if you want.

Click  button to save the New Cover 

Sheet.

[Edit] menu
Page Size : Sets the size of the cover sheet.

Date Frame : Inserts a date field.

Text Frame : Inserts a text box.

Line/Box : Inserts a line or box.

Image Frame : Inserts an existing image file (bmp file).

Recipient Details : Inserts the information set in the  and  tabs on the Personal
Address Book.

Sender Details : Inserts the information set in the  tab on the Setup menu.

Comment : Inserts a comment field for typing a brief message when sending a fax.

Subject : Inserts a subject field when sending a fax.

[View] menu
Show Grid : Displays the grid.

Preview : Displays the preview of the cover sheet.

Show Status Bar : Displays the status bar.

Zoom : Sets the ratio for the cover sheet editing screen.

Scale unit : Sets the scale unit of measure (cm/inch).

[Options] menu

Font : Specifies the character font.

Line Style : Specifies the line style.

Text Alignment : Adjusts the text position.

Date Format : Sets the date format.

Data Fields Personal

Sender Details
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Main Window

Main Window and Toolbar

(1) Fax No. Enter the destination fax number.

(2) Line Select Check the line type to dial the preset code before the telephone number.
See the Dial Setting Tab of Setup Menu.

(3) Recipient When this is entered, reflected on the cover sheet.

(4) Company When this is entered, reflected on the cover sheet.

(5) recipient(s) Indicates a number of entered stations

(6) Destination(s) Indicates entered destination station(s)

(7) Subject When this is entered, reflected on the cover sheet.

(8) Memo field When this is entered, reflected on the cover sheet.

(9) Cover Sheet Select various cover sheet or no cover sheet. 

(10) Attachment Indicates a number of pages attached. 

(11) Resolution Indicates a current sending resolution.

(1)

(2)

(3)

(4)

(5)

(6)

(7)

(8)

(9)
(10) (11)
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Main Window and Toolbar

Toolbar

Used to start the transmission.

Used to view the cover sheet or transmission file.

Used to select the file to be send.

Used to show the Send/Receive Log Manager.

Used to open your personal Phone book.

Used to create or edit a Cover Sheet.

Used to show the On-line help.
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Select Setup from the Tools menu to open Setup windows.

Setup Menu

Dialing Settings Tab
Specify the local, long distance and Inter-office call 
access numbers. These access numbers are dialed 
before the phone numbers that are registered in the 
Personal Adress Book depending on the Call Type 
settings.

Sender Details Tab
Used to identify yourself with various information on the 
Cover Sheet when sending a fax.

PIN Code Tab
Specify the PIN Code settings when required by your 
telephone system.
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Select Configuration from the Tools menu to open Configuration windows.

Configuration Menu

Send Option Tab
Device Name: A device can be chosen here when more 

than one device is connected with the 
network connection type devices.

Resolution: Resolution to be used for the 
transmission. The selectable resolutions 
depend on the machine's capability 
connected to your PC.

Setup Quality: Set the quality to be used for the 
transmission.

Cover Sheet Tab
Setting the usage of the Cover Sheet.

Various Settings Tab
The "Receiving Notice" is not available for the network 
connected type devices.
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Log of the transmission and the reception can be confirmed.

Send Log/Receive Log

1 Click the  button.

2 Send/Receive Log window appears.
Click Send Log and Receive Log to switch the Log 
window.
Status column

• Queuing: Send fax is queuing.
• Executing: Transferring the data to the device
• Terminated: Transferring the data is completed

Result
• OK: The fax sending is completed from

 the device.
• Error Code: The fax sending is uncompleted from

the device.
Note: 1 For the Send Only System, the Send Log 

shows whether only the transfer to the device 
succeeded. It confirms whether it reached the 
final destination by Job Completion Notice of 
the Status Monitor. Please refer to the Status 
Monitor section  for the detail.

2 For the Send Only System, it is not available 
with the Receiving Log.

3 For Send & Receive System, there is
Administrator Send Log that can check the all
client sending transactions. Select General
User to see the Own Send Log and
Administrator to see the Administrator Send
Log. The Administrator Send Log can be
setup the password for security.
133
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Network Status Monitor

Select Panasonic → Panasonic Document Management System → Network MFP Utilities →
Network Deceive Locator in Programs from the Start menu.
Upon activation of the Network Device Locator, attached printers will be automatically searched and
displayed in the list.

Contents of List

Right-click on your device to display the menu.

1. Status Monitor
Activates the Status Monitor.

2. Configuration Editor
Activates the Configuration Editor (See page 145).

3. Address Book Editor
Activates the Address Book Editor (See page 145).

4. Delete
Removes the device from the list.

5. Rename
Changes the name of the device.

6. Search
• Device Search

Search the devices manually.
• Device Search Ranges

Set the conditions to search the devices (See page 135).

7. Create Shortcut
Creates a Shortcut of the program for the selected device.

8. Delete Shortcut
Deletes the selected Shortcut.

Network Device Locator

Item Status

Device Name Name of the device.

Location Location of the device.

IP Address IP address of the connected device.

Make/Model Make and model number of the device.

Condition Display of Normal, Warning, Error, Powersaving, etc will be indicated after the
status of the connected device is detected.
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���� Device Search Condition
Select Search → Device Search Ranges from the Device Menu.

1. Panasonic Printers
Select if searching for Panasonic printers only.

2. All Printers
Select if searching for all printers.

3. Add
Add a new search range of IP addresses.

Click the  button and enter the Start IP Address and End IP Address.

4. Edit
Edit the selected IP address range.

5. Delete
Delete the selected IP Address range.

6. Detail
Enter the SNMP community name of the devices to be searched.

Add
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The Status Monitor is a Multi Functional Product (MFP) utility that monitors and displays the current status of
connected devices.
Upon activation, the icon of the Status Monitor(up to 10 different printers) appear on the System Tray next to
the system clock.

The Status Monitor indicates the device status by the icon lamp color as listed below.

Task Display

Lamp Status

Green Device is operational under standby, printing, scanning, or copying mode.

Yellow Device inspection is required, paper supply, etc.

Red Need for toner replacement, open cover, paper jam, or device failure.

Gray Device is in Energy Saver (sleep) Mode.
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Right-clicking the Status Monitor icon in the System Tray displays the following pop-up menu.

1. Open Status Monitor
Displays details about the current status of the device.

2. Start the Configuration Editor
Activates the Configuration Editor.

3. Start the Address Book Editor
Activates the Address Book Editor.

4. Auto Start
Sets the Status Monitor for the device to start automatically when the PC is rebooted.

5. Job Completion Notice
Sets the Job Completion Notification mode.

6. Message Display
Displays the contents (file name, etc.) of the Job Completion Notice when it is set to Icon (No Notice).

7. Pop up when error occurs
Selects whether or not a pop-up error message box appears when an error occurs on the connected
device.

8. About
Displays the version information about the Status Monitor.

9. Exit
Closes the Status Monitor.

Taskbar Menu
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Right-clicking the Status Monitor icon in the System Tray and selecting Open Status Monitor in the pop-up
menu displays the Status Monitor dialog box.

���� Status Tab

1. Model
Displays the names and model number of the connected device.

2. Status
Displays the current status of the device.
If two or more items have been detected, clicking  /  buttons allows viewing of other items.

3. Control Panel
Displays information as it appears on the panel of the device.
If two or more items have been detected, clicking  /  buttons allows viewing of other items.

4. Message
Displays the current status of the device in details.
If two or more items have been detected, clicking  /  buttons allows viewing of other items.

5. Status
Displays the communication status between the Status Monitor and the device.

Display Status Details
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���� Configuration Tab

1. Model
Displays the names and model number of the connected device.

2. Configuration
Displays a list with the current device configuration (optional devices, etc.).

3. Status
Displays the communication status between the Status Monitor and the device.
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Display Status Details

���� Paper Tab

The Paper tab displays the type, size, and paper status of each paper tray. A comment by the user can be
entered in the Paper Type field.
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���� Network Tab

1. Model
Displays the name and model number of the connected device.

2. Network Information
Displays a list of the current network status. (Number of packets for Sending/Receiving etc.)
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Display Status Details

���� Job List Tab

1. Model
Displays the name and model number of the connected device.

2. JOB List
Displays the current print jobs if the optional Hard Disk Drive Unit (DA-HD60) is installed.
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Before using the Job Completion Notice, choose the Status Monitor as follows;

• Pop up Display : Notify with the Pop-up message.
• Icon (Notice) : Notify with the Icon appear on the desktop and change the Status Monitor icon.
• Icon (No Notice) : Notify with the Status Monitor icon.
• None : Do not notify.

� Pop up Display
Displays the following message when the copy and/or print job is completed.

Job Completion Notice
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Job Completion Notice

� Icon (Notice) and Icon (No Notice)

Displays the Notification Icon  on your desktop if Icon (Notice) is selected, and changes the Status

Monitor icon.

Select the Message Display to show the message.

NOTE 1. See page 23 on the Operating Instructions for Copier & Network Scanner for the details.

Status Monitor icon
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Network Configuration Editor/Address Book Editor

These utilities allow you to edit the device’s Configuration or Address Book through the TCP/IP LAN
network using the FTP protocol. The desired device is first chosen from the device list of the Network
Device Locator and then the Network Configuration Editor or Network Address Book Editor can be started.

Note: Both utilities are installed when the "Administrator" mode is selected during the Panasonic-DMS
installation (See page 61).

General Description
145



Network Configuration Editor/Address Book Editor

146
Activation Procedure

1 Start the Network Device Locator. (See page 
134)

2 The Network Device Locator appears.
From the Toolbar
Select the device from the list and click the 

 or  icon.

From the Tools menu
Select the device in the list and select 
Configuration Editor or Address Book 
Editor from the Tools menu.

3 The Network Configuration Editor or Network 
Address Book Editor appears and retrieves 
the data from the device.
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Create Shortcut Links

1 Start the Network Device Locator. (See page 
134)

2 Click on the device and select Create 
Shortcut → Configuration Editor or 
Address Book Editor from the Tools menu.

3 The Shortcut Preparation window appears.

Select a Preparation Place and click the  

 button.

Note: As the shortcut or menu icon 
includes the IP Address, the shortcut 
or menu icon has to be recreated 
each time if the IP Address of the 
device is obtained using a DHCP 
server on the network.

4 The shortcut link is created at the selected 
location.

Create
147



Network Configuration Editor/Address Book Editor

148
Menus and Icons

Main Window

Help Bar: Input or operation guide help is indicated.

Status Indicator: Communication status and the latest communication result are indicated.

Menu Toolbar 
icon Description

File
New Creates a new blank file.

Open Opens an existing file.

Close Closes the active file.

Save Saves the settings to a file with its current name.

Save As Saves the settings to a file with a new name.

File Information Displays or changes the addresses of the device.

Font Selects the font which will print on reports.

Print Prints the active folder content.

Delete Deletes the file.

Export Exports the active folder contents to a text file.

Import Imports a text file to the activate folder.

Exit Shuts down the application.

Quit Closes the active window without saving data.

Edit Cut Removes selected lines and places them on the clipboard.

Copy Copies selection lines to the clipboard.

Help Bar Status Indicator Help Bar Status Indicator

Network Configuration Address Book
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Paste Pastes the contents of the clipboard at the insertion point of the
line.

Insert Line Inserts a line at the insertion point of the line.

Delete Line Deletes a line at the deletion point of the line.

Find Parameter Searches for specified text in the active file.

Set to default Sets all settings of the active folder to its default settings.

View
List Mode Displays list mode.

Detail Mode Displays detail mode.

Sort Selects the display sort mode.

Toolbar Shows or hides the Toolbar.

Status Bar Shows or hides the Status Bar.

Font Selects the display font.

Transfer
Retrieve Retrieves the current settings from the device.

Write Writes the settings to the device.

Display Log Displays the transfer log.

Tools
Device Address List Opens the Device Address List dialog.

Device Group List Opens the Device Group List dialog.

Options | General Opens the General setting dialog.

Options | FTP 
Configuration

Opens the FTP Settings dialog.

Window Tile Horizontal Arranges the open windows in smaller sizes to all fit in the same
window horizontally.

Tile Vertical Arranges the open windows in smaller sizes to all fit in the same
window vertically.

Cascade Causes all windows to overlap so that each title bar is visible.

Close All Closes all open windows.

Help Help Topics Displays Help Topics.

Supported Models Displays a list of supported models.

About Displays information about Network Configuration Editor / Address
Book Editor.

Menu Toolbar 
icon Description
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Retrieve Data

Basic Operation

1 When Network Configuration Editor or 
Network Address Book Editor is started from 
Network Device Locator or the pre-installed 
shortcut, it connects to the device, retrieves 
the data, and then displays it automatically.

A Process status is indicated in the bottom 
right side of the window.

Note: If the device password is changed 
(Key Operator Code) from the default 
value (0000), it is not possible to 
retrieve the data. 
In this case, enter the password in 
advance to the Default Password in 
the Tools → Options → FTP 
Configuration....

2 If you want to retrieve the latest data again 

from the device, click the  icon, or select  

Retrieve from the Transfer menu.
Note: If the device is in an operating 

condition copying, printing, etc...), it 
is not possible to retrieve the data 
(Retrieving error). Try again later 
after the device enters the standby 
condition.

Status Indication
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Edit Data

1 Network Configuration Editor Modify parameters using Network 
Configuration Editor.

When a function is chosen in the left pane of 
the window, the display of the right pane 
changes.

Note: Fields on the left show what items 
have been changed.
*: An item which is different from 

default setting.
#: An item that has been changed.

2 Network Address Book Editor Modify, add or delete Address Book entries 
using Network Address Book Editor.

The type of Address Book to view or work with 
is chosen in the left pane of the window.

Note: 1.The Tandem Copy Address Book is 
available only when the optional 
Hard Disk Drive Unit (DA-HD60) is 
installed in the device.

2.The Fax Address Book is available 
only when the optional Fax 
Communication Board (DA-FG600) 
is installed in the device.
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Basic Operation

Write Data

1 If you want to write the edited data to the 

device, click the  icon, or select Write 

from the Transfer menu.

2 Select  to start writing to the 

device.

3 Process status is indicated in the bottom right 
side of the window.

Note: If the device is in an operating 
condition copying, printing, etc...), it 
is not possible to write the data 
(Writing error). Try again later after 
the device enters the standby 
condition.

Yes

Status Indication



Network Configuration Editor/Address Book Editor

D
oc

um
en

t M
an

ag
em

en
t 

Sy
st

em
 S

ec
tio

n

Save retrieved data file

Advanced Operation

1 To save the retrieved setting data, click the 

 icon, or select Save As from the File 

menu.

2 To Save File:
1. Select an existing file from the list or 

enter a new filename.

2. Click the  button.
The data is saved to a file.

OK
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Advanced Operation

Open saved file

1 To open a saved file, click the  icon, or 

select Open from the File menu.

Note: To start Network Configuration Editor 
or Network Address Book Editor, 
click [Configuration Editor] or 
[Address Book Editor] without 
selecting the device in the Network 
Device Locator. The editor will open 
without retrieving data from the 
device.

2 To open a file:
1. Select a file from the list.

2. Click the  button.OK
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Create new file

1 To create a new file, for example to perform 
registration of an address book without 

connecting to the device, click the  icon, 

or select New from the File menu.

Note: To start Network Editor, click 
[Configuration Editor] or [Address 
Book Editor] without selecting the 
device in the Network Device 
Locator. The editor will open without 
retrieving data from the device.

2 The File Information window appears.

Click  to select the model number.

Enter the device name, location and IP 
Address of the device (optional).

Enter the login password (Key Operator Code) 
of the device (optional).

Click the  button.

3 The Save As window appears.

Enter a new filename.

Click the  button.

4 The editing window appears.

Edit items as necessary.

OK

OK
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Advanced Operation

Registering the Device Address List

1 To open the Device Address List, click the 

 icon.

2 Click the:

 button:
To acquire the network address list of the 
Network Device Locator.

 button:

To enter a new address setting into the dialog 
boxes.

 button:
To select the address that you want to edit and 
edit the current settings.

 button:
To select the address that you want to delete.

 button:
To connect the address that you want to 
retrieve and display the data.

 button:

To make the changes effective, and to close 
the window.

 button:
To discard all changes and close the window.

Acquire

Add...

Edit

Delete

Connect

OK

Cancel
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Registering the Group List

1 To open the Device Group List, click the  

icon.

2 The Group Name List, lists the registered 
groups.

Click the:

 button:
To create a new group. 

Enter a name and click .

 button:
To change the name of the selected group.

Enter a new name and click .

 button:
To delete the selected group.

The Device Address List, lists the addresses 
of registered devices.

Click the:

 button:
To acquire your network address list that the 
Network Device Locator detected.

The Group Member section lists registered 
addresses for the selected group.

Use the   buttons to add or delete the 
selected address from the group members.

New

OK

Update

OK

Delete

Acquire
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Advanced Operation

Using the Device Address List and Device Group List

The destination can be specified in the Address Book or Group List.

1 The confirmation window appears before 
retrieving or writing data.

Click the  button.

2 Destination section:
This shows the addresses currently chosen.

3 Manual Inpu tab:

Enter the address and click the  button 
to add the address to the destination.

4 Device Address List tab:

The addresses which the Address List and 
Group List registered are shown.

Select an address, and add or delete it by 

clicking the  or  button.

Note: Multiple destinations can be entered 
only when Dept Code only is 
selected from the Transfer | Write 
menu.  [Options...] is indicated when 
there is a writing option.

5 Click  to return to the 

Confirmation window.

Change Dest.

OK
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Using Timer Communication

Cancel Timer Communication

1 The confirmation window appears before 
retrieving or writing data.

Click the  button.

2 Timer section:
Click Enable and select the time that you want 
to start communication.

Click  to create the job to standby 

in the spooler until the start time.

1 Click Spooler in the taskbar to open the 
Spooler.

2 If you need to cancel the job, select the job 
and choose Delete from the Spooler menu.

Change Dest.

OK
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Advanced Operation

Editing the Address Book Editor – Copy and Paste Address Book data 

1 Open the source data file and target data file.  
(See page 145)
Select Window → Tile Horizontal.

2 Select the range that you want to copy.

Click on the first number that you want to copy 
and then click on the last number that you 
want to copy while pressing [Shift] key.

or

Click on the first number that you want to copy 
and drag the mouse until you reach the last 
number you want to copy.

3 Right-click on the selection and select Copy, 
or select Copy from the Edit menu.

4 Click on the first number where you want to 
paste the data.
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5 Right-click and select Paste, or select Paste 
from the Edit menu.

6 The data is pasted at the designated point.

Note: The data which exceeds the 
maximum number of allowable 
addresses will be lost.
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Advanced Operation

Editing Address Book Editor – Import Address Book data from other application

Address Book data created using other applications, such as Microsoft Excel, can be imported.

1 Copy the Address Book data from the other 
application.

The data format must be Address (IP Address/
Fax number/Email Address), Destination 
Name and Key Name.

2 Click on the number where you want to paste 
the data.

Right-click and select Paste, or select Paste 
from the Edit menu.

3 Data is pasted at the designated point.

Note: The data which exceeds the 
maximum number of allowable 
addresses will be lost.
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Troubleshooting

Troubleshooting

If the printing operation fails, check the following items first:

• The connection cable (Parallel Printer cable or Ethernet LAN cable) is properly connected.
• Power of the device is turned ON.
• Paper is loaded properly in the device.
• An error message is not displayed on the device. (See Note 1)

The above points can be verified by printing a test page. Refer to the following for procedures on test page
printing:

NOTE 1. The status of the devices can be verified by the status monitor  (See page 134).

Printing Operation Fails

Windows 98/Me [General Tab]  (See page 26)

Windows NT 4.0 [General Tab]  (See page 33)

Windows 2000/XP [General Tab]  (See page 42)
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Document is Not Printed Correctly

Problem Possible Solution(s)
Printing position is wrong or print is
missing at the edge.

Paper size or printing orientation is different between the application settings and
the printer driver settings. Specify the settings again.
The specified paper has not been loaded on the device.
Specify the settings again or load the appropriate paper.
The document margin is not sufficient. On the machine, a margin of approx. 0.1
inch (2.5 mm) or more is required at the sheet edges.
(Recommended printing margin) Adjust the margin correctly.

Characters and symbols not used in
documents are printed.

Verify that your machine has been selected as the printer driver.

Printing operation takes excessive
time.

The wait time for printing operations depends on the spool settings.
Select Spool print jobs so program finishes printing faster in spool settings.

• Reference :
Windows 98/Me [Details Tab]  (See page 27)
Windows NT 4.0 [Scheduling Tab]  (See page 35)
Windows 2000/XP [Advanced Tab]  (See page 45)
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Error Messages Displayed on the Computer

Problem Possible Solution(s)
Error in writing to LPT1.
Unable to write to the Specified
device.

Verify that the device is connected to the computer correctly.
Verify that the power of the device is turned on.
Verify that the paper is properly loaded.

Error in writing to LPT1.
Printer timeout error occurred.

Verify that the power of the device is turned on.
Excessive data volume or number of pages may overflow the device's memory,
disabling data reception.
Increase the timeout setting value in properties (for transmission retry).

• Reference :
Windows 98/Me [Details Tab]  (See page 27)
Windows NT 4.0 [Ports Tab]  (See page 34)
Windows 2000/XP [Ports Tab]  (See page 44)

Printing is disabled due to an error in
the current printer settings.

Differences in settings such as paper size or printing orientation exist between the
application and the printer driver.
Specify the correct settings.
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Appendix

Appendix

When printing to the device, there is a 0.1 inch (2.5 mm) non-printable area on all 4 sides.

Printing/Scanning Area

Top

0.1/2.5

0.1/2.5

0.1/2.50.1/2.5

Bottom (Unit: inches/mm)
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For Service, Call:

WARRANTY

U.S.A. Only

PANASONIC DOCUMENT IMAGING COMPANY MAKES NO WARRANTIES, GUARANTEES OR
REPRESENTATIONS, EXPRESSED OR IMPLIED, TO THE CUSTOMER WITH RESPECT TO THIS
PANASONIC MACHINE, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

PANASONIC DOCUMENT IMAGING COMPANY ASSUMES NO RISK AND SHALL NOT BE SUBJECT
TO LIABILITY FOR ANY DAMAGE, INCLUDING, BUT NOT LIMITED TO DIRECT, INDIRECT,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OR LOSS OF PROFITS SUSTAINED BY
THE CUSTOMER IN CONNECTION WITH THE USE OR APPLICATION OF THIS PANASONIC
MACHINE. SEE YOUR DEALER FOR DETAILS OF DEALER’S WARRANTY.

Published in Japan
April 2002
DZSD001581-2
T0302-1042

Matsushita Electric Industrial Co., Ltd.
Website : http://www.panasonic.co.jp/global/

Panasonic Document Imaging Company
A Business Unit of Matsushita Electric Corporation of America 
Two Panasonic Way
Secaucus, New Jersey 07094

Panasonic Canada Inc.
5770 Ambler Drive
Mississauga, Ontario L4W 2T3
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